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Digidesign.

003, 96 I/O, 96i I/O, 192 Digital I/O, 192 I/O, 888|24 I/O, 882|20 I/O, 
1622 I/O, 24-Bit ADAT Bridge I/O, AudioSuite, Avid, Avid DNA, Avid Mojo, 
Avid Unity, Avid Unity ISIS, Avid Xpress, AVoption, Axiom, Beat Detective, 
Bomb Factory, Bruno, C|24, Command|8, Control|24, D-Command, D-Control, 
D-Fi, D-fx, D-Show, D-Verb, DAE, Digi 002, DigiBase, DigiDelivery, Digidesign, 
Digidesign Audio Engine, Digidesign Intelligent Noise Reduction, Digidesign 
TDM Bus, DigiDrive, DigiRack, DigiTest, DigiTranslator, DINR, D-Show, 
DV Toolkit, EditPack, Eleven, HD Core, HD Process, Hybrid, Impact, Interplay, 
LoFi, M-Audio, MachineControl, Maxim, Mbox, MediaComposer, MIDI I/O, MIX, 
MultiShell, Nitris, OMF, OMF Interchange, PRE, ProControl, Pro Tools M-Powered, 
Pro Tools, Pro Tools|HD, Pro Tools LE, QuickPunch, Recti-Fi, Reel Tape, Reso, 
Reverb One, ReVibe, RTAS, Sibelius, Smack!, SoundReplacer, Sound 
Designer II, Strike, Structure, SYNC HD, SYNC I/O, Synchronic, TL Aggro, 
TL AutoPan, TL Drum Rehab, TL Everyphase, TL Fauxlder, TL In Tune, 
TL MasterMeter, TL Metro, TL Space, TL Utilities, Transfuser, Trillium Lane Labs, 
Vari-Fi Velvet, X-Form, and XMON are trademarks or registered trademarks of 
Digidesign and/or Avid Technology, Inc. Xpand! is Registered in the U.S. Patent 
and Trademark Office. All other trademarks are the property of their respective 
owners.

Product features, specifications, system requirements, and availability are 
subject to change without notice.

Part Number 9321-61201-00 REV A 03/09

Documentation Feedback
At Digidesign, we're always looking for ways to improve our documentation. If you 
have comments, corrections, or suggestions regarding our documentation, email 
us at techpubs@digidesign.com.

Communications and Safety Regulation Information

Compliance Statement
This model Digidesign XO16 Analog/Digital Output Card complies with the 
following standards regulating interference and EMC:
• FCC Part 15 Class B
• EN 55103-1 E3
• EN 55103-2 E3
• AS/NZS 3548 Class B
• CISPR 22 Class B

Radio and Television Interference
This equipment has been tested and found to comply with the limits for a Class B 
digital device, pursuant to Part 15 of the FCC Rules.

DECLARATION OF CONFORMITY
We Digidesign,
2001 Junipero Serra Boulevard, Suite 200
Daly City, CA 94014 USA
tel: 650-731-6300
declare under our sole responsibility that the product
XO16 Analog/Digital Output Card 
complies with Part 15 of FCC Rules. 
Operation is subject to the following two conditions:  (1) this device may not 
cause harmful interference, and (2) this device must accept any interference 
received, including interference that may cause undesired operation.

Communication Statement
NOTE: This equipment has been tested and found to comply with the limits for a 
Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are 
designed to provide reasonable protection against harmful interference in a 
residential installation. This equipment generates, uses, and can radiate radio 
frequency energy and, if not installed and used in accordance with the 
instructions, may cause harmful interference to radio communications. However, 
there is no guarantee that interference will not occur in a particular installation. 
If this equipment does cause harmful interference to radio or television 
reception, which can be determined by turning the equipment off and on, the user 
is encouraged to try and correct the interference by one or more of the following 
measures:
• Reorient or locate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which 

the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.

Any modifications to the unit, unless expressly approved by Digidesign, could 
void the user's authority to operate the equipment.

Canadian Compliance Statement:
This Class B digital apparatus complies with Canadian ICES-003. 

Cet appareil numérique de la classe B est conforme à la norme NMB-003 du 
Canada.

Australian Compliance

European Compliance

XO16 Analog/Digital
Output Card
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Chapter 1: Overview

The XO16 Analog/Digital Output Card from Digidesign® pro-
vides eight analog line outputs and four stereo digital outputs 
to your VENUE Mix Rack or VENUE SC48™ console.

XO16 Card Components
The XO16 Card includes the following items: 

• XO16 Card

• Mounting screws

• Digidesign Registration Information Card

• This guide

XO16 Card Capabilities and Features
The XO16 Card provides the following:

• Eight channels of analog line level outputs via 
XLR3-male connectors

• Eight channels of AES3 digital outputs via four 
XLR3-male connectors. Each connector carries two digi-
tal audio channels. 

System Requirements
One of the following are required to use the XO16 Card with 
your installed and configured VENUE system:

• A Mix Rack with an available output card slot 

– or –

• An SC48 console with an available output card slot

For complete system requirements, visit the Digidesign 
website (www.digidesign.com).

Figure 1.  XO16 Analog/Digital Output Card

Analog Outputs 1-8 AES Digital Outputs 9-16
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Conventions Used in This Guide
All Digidesign guides use the following conventions to indi-
cate menu choices and key commands in D-Show and 
Pro Tools:
:

The names of Commands, Options, and Settings that appear 
on-screen are in a different font.

The following symbols are used to highlight important infor-
mation:

Convention Action

File > Save Session In Pro Tools, choose Save 
Session from the File menu.

Options > System Config In the D-Show software 
screen, click Options to dis-
play the Options page, then 
click the System Config tab.

Ctrl+N Hold down the Control key 
and press the N key.

Ctrl-click Hold down the Control key 
and click the mouse button.

User Tips are helpful hints for getting the 
most from your VENUE system.

Important Notices include information that 
could affect data or performance.

Shortcuts show you useful keyboard or 
mouse shortcuts.

Cross References point to related sections in 
the D-Show or Pro Tools Guides.
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Chapter 2: Installing the XO16 Card

This chapter provides information on installing an XO16 card 
in a Mix Rack or an SC48 console.

For instructions on installing a card in a Mix Rack, see “Install-
ing an XO16 Card in Mix Rack” on page 3.

For instructions on installing a card in an SC48, see “Installing 
an XO16 Card in SC48” on page 5.

Installing an XO16 Card in Mix Rack
Mix Rack has two available output card slots, slots D and E. 
X016 cards can be installed in either or both slots. These in-
structions assume that you already have an Analog Output 
Card (AO16) installed in slot D and that slot E is empty.

To install an XO16 Card:

1  Shut down the VENUE system, and turn off power to the 
Mix Rack. 

2  Disconnect all cables from Mix Rack. 

3  Remove Mix Rack’s front panel cover by unscrewing its 
mounting screws (#1 Phillips).

If you are replacing an XO16 Card or you want to install 
two in your Mix Rack, you must first remove a card. See the 
Venue Service Guide for more information on removing and 
replacing cards.

Mix Rack front panel

Mounting screws (remove all)
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4  On Mix Rack’s back panel, locate output slot E.

5  Remove the card from its packing material. Hold the card by 
its edges.

6  Gently slide the card into the output slot.

7  When the card is seated in its slot, use the captive thumb-
screws to secure the card to Mix Rack’s chassis in the back of 
Mix Rack. 

8  Secure the card to the front panel of Mix Rack using the four 
mounting screws you removed earlier.

9  Find the Hub48 Board ribbon cable that corresponds to the 
output slot in which you have installed the XO16 Card. The 
Hub48 board’s five ribbon cables connect to the Input and 
Output Expansion Cards.

10  Connect the ribbon cable to the card socket on the XO16 
card.

Make sure the pins on the socket are correctly aligned with the 
ribbon cable connector. Secure the connection by moving the 
retaining clips on each side of the socket connector inward. 
Check to make sure the ribbon cable is connected securely.

If you are installing the XO16 Card in a slot with a card 
slot cover, you must first remove the card slot cover.

Mix Rack back panel

Output 
slot E

Do not remove or re-seat the ribbon cable connections on 
the Hub48 Board while the board is installed in the Mix 
Rack. This may cause excessive flexing of the Hub48 Board. 
If necessary, disconnect the Hub48 and all input and out-
put card ribbon connections, and remove the entire assem-
bly from the rack prior to changing connections.

Detail of back of Mix Rack, the Hub48 Board, and the ribbon cables

Mix Rack contains 5 ribbon cables that connect to the input 
and output cards. The top two ribbon cables connect to the 
output cards installed in Output Slots D and E.

A properly connected Expansion Card

Connects to card 

Connects to card
in Output Slot E

in Output Slot D

 

Hub48 Board
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Completing and Confirming Installation

To complete and confirm installation:

1  Reattach the Mix Rack’s front panel.

2  Reconnect the power and any audio cables to the Mix Rack.

3  Turn on the system.

4  Go to the Options page and click the Devices tab to view 
your system hardware status. The newly installed XO16 Card 
should be displayed.

\

5  Go to the Patchbay page and click the Stage tab to verify 
that the XO16 card appears in the patchbay. The XO16’s ana-
log outputs appear under “Analog Card D.” The digital out-
puts appear under “Digital Card E.”

6  In the standalone software, right-click the Mix Rack graphic 
to see and modify your Mix Rack’s input and output card con-
figuration. XO16 Cards appear as “Analog/Digital Output 
Card” in the pop-up menu.

Installing an XO16 Card in SC48
Your SC48 has two available output card slots, slots D and E. 
These instructions assume you already have an output card in-
stalled in slot D and that slot E is empty.

1  Shut down your system, and turn off power to the SC48. 

2  Disconnect any power cables from the SC48, as well as any 
other audio cables that may get in your way.

3  On the back panel of the SC48, locate output slot E.

4  Remove the four screws holding the card slot cover in place. 
You can use a flathead screwdriver to pry the cover away from 
the output slot after removing the screws.

Keep the screws nearby for securing the card to the SC48.

5  Clip the cable tie to free the ribbon cable that is attached to 
the inside of the card slot cover.

If the Expansion Card does not appear in the Mix Rack 
graphic, check the ribbon cable connection. Disconnect and 
reconnect the ribbon cable to the Expansion Card, making 
sure to properly seat the connector in its card socket.

Detail of Devices tab indicating presence of one XO16 Card

Detail of standalone software’s Devices tab pop-up menu showing XO16 
Card in Slot E of Mix Rack

If you are replacing an XO16 Card or you want to install 
two in your SC48, you must first remove an output card. See 
the VENUE SC48 Service Guide for more information on 
replacing or removing cards.

Left side of the SC48 back panel

Use care when prying away the card slot cover. The ribbon 
cable that you connect to the output card is attached to the 
inside of the card slot cover.

Clip the cable tie to free the ribbon cable

Slot E (remove card slot cover)
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6  Remove the card from its packing material. Hold the card by 
its edges.

7  Connect the ribbon cable to the card socket. Make sure the 
pins on the socket are correctly aligned with the ribbon cable 
connector. The retaining clips on each side of the socket con-
nector automatically close when the cable connector is prop-
erly seated. Check to make sure the ribbon cable is connected 
securely.
.

8  Slide the output card into the slot, firmly pressing on both 
ends of the card so that it fits snugly in the slot.

9  Secure the card to the rear panel using the four screws you 
removed earlier.

Completing and Confirming Installation

To complete and confirm installation:

1  Reconnect the power cable and any other cables to the 
SC48.

2  Turn on your SC48.

3  Go to the Options page and click the Devices tab to view 
your system hardware status. The newly installed card should 
be displayed.

\

4  Go to the Patchbay page and click the Stage tab to verify 
that the XO16 Card appears in the patchbay. The XO16’s eight 
analog outputs appear under “Analog Card D.” The eight dig-
ital outputs appear under “Digital Card E.”

5  In the standalone software, click the Devices tab on the Op-
tions page. You can right-click the SC48 graphic to see and 
modify your SC48’s input and output card configuration.

Connecting the ribbon cable to the card socket 

Installing the XO16 Card

If the card does not appear in the graphic, check the ribbon 
cable connection. Shut down your system, then disconnect 
and reconnect the ribbon cable to the output card, making 
sure to seat the connector properly in its card socket.

Detail of Devices tab indicating presence of an XO16 card

Detail of standalone software’s Devices tab pop-up menu showing 
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Chapter 3: Specifications

Audio Specifications

All measurements at Fs=48 kHz with 150 Ohm source impedance and 600 Ohm load impedance, unless otherwise specified.

0 dBU = 0.775Vrms.

XO16 Analog Line Outputs

Parameter Specifications Limit Units Condition/Comment

Type Balanced, XLR3-Male

Impedance 50 Ohm Each leg to ground

Maximum Output Level +24 max dBu

D/A Converter Latency 0.58 ms Fs=48kHz

XO16 Digital Outputs

Parameter Specifications Limit Units Condition/Comment

Type Balanced, XLR3-Male

Format AES3 (IEC-60958 Type I)

Impedance 110 Ohm Each leg to ground

Word Length 24 bit

Sample Rate 48 kHz

Sample Rate Conversion None

Dithering None

Channel Status Info Pro, Audio 48K, No Emphasis

Max Cable Length 100 meter Without equalization, 110 Ohm 
cable
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